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This guide is a supplement to the manual that comes with Imposition Publisher. To find out how
to use Imposition Publisher and its features please refer to the manual.
This guide covers the installation and running of the Client-Server version. It details the
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What is Imposition Publisher Client-Server?

The Client-Server version is a special version of Imposition Publisher where the work is shared
between two computers connected over a network: the workstation (Client) and the central
computer (Server) that performs most of the processing.

This method allows greater throughput of work for less cost. The Server machine is usually very
powerful so that the processing of PostScript and PDF files is very fast, whilst the Client
machine, which does not need to be so powerful, allow the user to set up and send jobs to the
Server for processing.

At present, the Imposition Publisher X Server is available on Windows, Sun Solaris, Linux x86
and Mac OS X Server platforms. The Client is available only for Mac OS X.

The Client-Server version comes with a 5 user license, which allows 5 specific workstations to
impose work. Should you need more than 5 licenses, contact your supplier to upgrade the
software. This will only involve entering a new release code for the Server.
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System Requirements

For the Server on Windows (Minimum):

e Pentium 500 MHz or faster

e 512MBRAM

e  Windows 2000, XP, Vista or later

* Sufficient hard disk space for input and output PostScript and PDF files

For the Server on Solaris (Minimum):

Sparc 20 or later

512 MB RAM

Solaris 2.4 or later

Sufficient hard disk space for input and output PostScript and PDF files
Helios EtherShare, Xinet or similar

For the Server on Linux x86 (Minimum):
*  Pentium 500 MHz or faster
512 MB RAM
* Sufficient hard disk space for input and output PostScript and PDF files
e Helios EtherShare, samba, netatalk or similar

For the Server on Mac OS X Server (Minimum):
e G4, G5 or Intel based Mac
* 512MBRAM
* Sufficient hard disk space for input and output PostScript and PDF files
¢ Mac OS X Server (10.3 or newer)
* Helios EtherShare or built-in file sharing services

For each Apple Macintosh Client (Minimum):
e 512 MBRAM
* 15 MB hard disk space to install
e MacOS X (10.3 or newer)
e A connection to the Server over a network
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Installing and Running the Server on UNIX

Note: In the examples given, the angle brackets (< >) denote text to be substituted by the user, as
it may be site-specific.

Installation

The installation CD contains the UNIX software for Imposition Publisher Client-Server. The
installation .tar file can be found inside the UNIX Server folder on the CD (select the
appropriate platform). Copy this file to your UNIX server. Then change directory to
/usr/tmp. Then type the following to extract the installation files from the .tar file.

tar xvf <name-&-path-of-the-.tar-file>

Then to install the software make sure you are in the directory that you extracted the tar files
to. Then become root or superuser by typing :-

su

< enter password here if any >

Then type: -

./install_ips
The install script will ask you for:

1. An installation path. This is where the server software will be installed, inside a
directory named ipserver.

2. The UNIX directory name and path, which maps onto the shared login Macintosh
network volume. Make sure that the path you enter is correct, as otherwise the server
software will not work.

Once you have answered these two questions the installation will start.

3. Once this is complete, you will be asked if you wish to create automatic start-up and
shut down links. If you answer yes, the software will automatically be stopped and
restarted when the machine is brought down and rebooted.

4. Next you will be asked if you received a dongle with your copy:-

If you answer y (for yes) to this question you will be asked if you want to run the dongle
setup program. Again if you answer y (for yes) you will then be asked which serial port
your dongle is attached to (a or b). Then you will be asked to enter your 12-digit dongle
code and release code (you should have received these on a flyer with your dongle).

If you answer n (for no) to this question the software will print out a reference for your
machine and ask if you have a password for this reference. At this point phone your
supplier with your reference number and they will give you a password and release code
in return. Then answer y (for yes) to the password prompt and enter your password
including the dashes (-) and release code without dashes.

5. The next step is to setup the printers and volumes to be used with the Clients. If you are
using any combination of EtherShare, PCShare, Xinet or UShare this can be done
automatically. Just select the appropriate option on the Network Setup menu.
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If you are using another networking solution select Other... from the menu option list and
follow the instructions below to setup your printers and volumes.

Setting up Printers

The menu driven script (setup-printers) allows you to manually add or delete names
from the list of printers seen by the clients and to specify a UNIX print command. When
you print from a Client, the server software uses this command to print your output to a
UNIX printer. It does this by adding the printer name and the output file to the UNIX
print command.

For Example. Using Helios EtherShare printer queues, you can follow these steps for
Imposition Publisher Server to print to these queues.

o

Type the following command to list all EtherShare printer queues :-

<name-&-path-of-your-EtherShare-directory>/lpc stat
This will list all the EtherShare printer queue names and their associated status.

b. Choose option 1 Add a printer... from the menu. Then type in the EtherShare printer
names pressing RETURN after each. When you have finished press RETURN to
return back to the menu screen.

c. Choose option 4 Configure print command... from the menu. Then enter y and press
RETURN to change the current UNIX printer command. Then enter the following
and press RETURN :-

<name-&-path-of-your-EtherShare-directory>/1pr -P

d. From the menu screen choose option 5 Quit.

Setting up Volumes

The menu driven script (setup-volumes) allows you to manually add or delete volume
entries from the list of volumes seen by the Clients. Only those volumes that have been
set up this way can be used with the Imposition Publisher Software.

To add a new volume you should select choice 1. You will be prompted for the UNIX
path and the corresponding Macintosh name. All names are case sensitive. Changes are
saved when you select choice 4 Quit.

Note: You will not be able to use the software until at least one volume has been set up.

6. Before finishing you will be prompted to search for Distiller. You should answer y if you
want to preview PostScript files and have Acrobat Distiller installed on your UNIX
server.

In the ipserver/ip folder the file ippreview.cmd will be created which will contain
path to the Distiller. It is in the form IPPREVTOOL=/usr/bin/distill. If you wish you
can edit it manually (e.g. in case you have multiple installation of the Distiller).

Note: If you don’t have Distiller installed on the server, the Mac Client will perform
the PostScript to PDF conversion.

Your Imposition Publisher Server software should now be installed and ready for use.

Starting the Server

The Server software on UNIX must be running before you run the Client software.
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If the automatic startup option was selected on installation, the Server program will
automatically start when you reboot your machine and will be stopped when your machine is
shutdown.

However, if you wish to start it without rebooting, do the following:

1. Change directory to the ipserver directory. Type:

cd <my-installation-path>/ipserver

Note: the text <my-installation-path> denotes the install path you entered when you ran the
installation script.

2. Type :-

./start-ipserver
or

./start-ipserver -DEMO
to start as demo. If you run the demo version you will be given a 12 digit demo key. Phone
Farrukh Systems with this key, you will be given a release code that will last for a limited
number of days. This key is invalidated if the software is shut down, but you can phone again
for another release code. Other than this the demo mode is fully functional.
Note: When starting up a Macintosh client for the first time, you will be prompted to select the

login folder on the server volume. This folder is called iplogin and will have been created by
the server installation script.

Stopping the Server

If you need to shutdown the Imposition Publisher server without shutting down your machine do
the following:

1. From the same directory, type :-
./stop-ipserver
or

./stop-ipserver -DEMO

if you are running as demo.

Miscellaneous

1. If you incorrectly type the UNIX path name for the shared Macintosh login volume in the
installation, you can edit the .ipconfig file, as root, in the ipserver directory. The format is
as follows :-

APPDIR=<ipserver directory path>

LOGINDIR=<iplogin directory path>

NETDIR=<directory path for the Mac network volume>

2. You can obtain your installation reference number at any time from the ipserver directory by
typing, as root or superuser :-
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./ipref
3. If you did not enter your password at the end of the installation script, you can do so from
the ipserver directory, as root or superuser, by typing :-
./ippass enter
Next, type:-
./ippassrelease
to enter the release code.

4. If you have a problem entering your dongle code on installation then you can re-enter it from
the ipserver directory, as root or superuser, by typing :-

./dngsetup -DNGNUMONLY

5. You can update your list of volumes and printers after installation from the ipserver
directory, as root or superuser, by typing :-

./config_net
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Installing and Running the Server on Windows

Installation

1. Insert the installation CD into your computer's CD drive.
2. In Windows Explorer view the contents of the CD. Navigate to the Imposition
Publisher\ ClientServer\ Windows folder. Double click the file IPXServerWin.exe. This

will launch the installation program.

3. Follow the instructions given by the installation program. During the installation you will
be given the opportunity to change the location where the software is installed.

4. When the installation is complete, Imposition Publisher Server will be on the Start Menu
and a shortcut will appear on the Desktop.

Dongle Driver Installation

Before you can run Imposition Publisher Server, the driver for the dongle must be installed on
your Windows system. This should happen automatically on the first run.

If the automatic driver installation is unsuccessful, you should try the dongle driver manual

installation. Follow the instructions in the file ReadMe.txt in your Imposition Publisher Server
directory.

Running Imposition Publisher Server for the First Time

When you first run Imposition Publisher Server, a dialog will appear prompting you to enter
your dongle number, release code, and the path of the shared directory.

1. Make sure that the dongle you received with this copy is connected to the parallel/USB
port.

2. Start Imposition Publisher Server from the Start button or the Desktop shortcut.

3. In the Install dialog, enter your 12 digit dongle number and release code. (The numbers will
be printed on a separate flyer).

4. In the same dialog, enter the path of your network shared directory in the box provided.

E.g. The shared directory to enter would be D: \ if all of the D: drive files and directories
could be seen from the network volume on your Client machines. The iplogin folder will be
created as D:\iplogin.

5. Click OK. The Imposition Publisher Server main window and startup screen should appear.

Next time you start the Imposition Publisher Server the software will start up straight away
without prompting for this information.

Note: If you make a mistake when specifying the network shared directory, the Server software
will start up, but the clients will be unable to login. If this happens choose Reset Installation
from the Edit menu. The next time you start the server program the Install dialog will appear.
Then you will be able to enter the correct shared volume path.
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Installing and Running Clients

1. Before installing and running Imposition Publisher Clients, make sure the Server is
installed and running,.

2. Make sure you are able to see the server volumes on your Client machine.

3. Install Imposition Publisher Client on your workstation. Refer to the ReadMe file for
further details on how to install Imposition Publisher.

4. Run Imposition Publisher. Dismiss the Demo warning by clicking Later.

Imposition Publisher Demo

This is a Demao version. It works like the full version except that all output is
marked by a demo watermark and saving to disk is disabled.

To try out the full version contact your nearest distributor (see below) for a
release code. Quote the demo code: 631257854847

£ UK Farrukh Systems Ltd. 0208 207 4249
BE |5 Global PrePress Systems (B00) 339 0363
€% Rest of World Farrukh Systems Ltd. +44 20 8207 4249

Enter release code:

( Later ) DK

5. From the Edit menuy, select License. You will be prompted to personalise your copy. Enter
your name and company. Change the Version popup to Mac Client. You do not have to enter
a Dongle Number or Release Code for the Client software.
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License

Flease perzonalise thiz copy:

x [ .
Version: | Mac Client Hq

Mame: Farrukh

Company: éFarru kh Systems J

li Cancel ) m

6. Click OK. The Connect to Servers dialog will appear:

Connect To Servers

Status Mame Server | |

i

8. Click the plus (+) button. You are then prompted to login to a Server:

Connect To Server

Login Folder: ;I I

Login Name: Farrukh

@m CCam:eI ) ( Connect )

4
T —"

9. Click Browse and navigate to the network shared volume and select the iplogin folder (this
folder is created by the Server onits first run). Then click Connect. If you have logged in
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successfully, there will be a black dot inside the radio button. Click OK to dismiss the
Connect To Servers dialog.

Connect To Servers

Status _Namu _S-I:r'.-':r
fat Mike, 1 DATA fiplogin

i

i 5o 0k

10. The Connect To Servers dialog allows you to log onto multiple Servers, if required. Click OK
to complete the login procedure.

Now you are logged in, you are ready to go.

Note: The next time you run Imposition Publisher, logging onto the Server will be automatic.

If there are any problems installing or logging onto the Server

If the Server is unable to log you in, then check the following:

Try repeating steps 5-11.

The Server part is actually running.

The Server's volume is accessible to the Client. For the Mac it should be on your
Desktop.

The correct login folder has been selected.

A correct login name has been supplied. If the name is already in use you will need to
enter another name and try again.

If the number of users logged onto the Server has reached the limit allowed by your user
license, then you will not be allowed to login. You will need to uninstall one of the other
users (See below for how to do this).

If nothing seems to work then contact your supplier or Farrukh Systems directly. (See the
Imposition Publisher manual for how to get Technical Support).

10
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Using the Client-Server Version

Imposition Publisher Client-Server version is almost identical to the standalone version in
terms of operation. For information on how to use the features of Imposition Publisher please
refer to the online help and the manual.

However, there are a few differences:

1. File Locations
The following files must be on the server, as the Server is unable to access files on the Client

machine:-

* All input PostScript and PDF files

* All output PostScript and PDF files

* All EPS and PDF files used in custom print marks

Any PostScript or PDF files you want to download using Imposition Publisher

Every time you add files to a file list or print a job, a message is sent to the Server which
then performs the relevant task.

2. Printing

The Print dialog on the Client displays a list of server printers. The printer that appears by
default can be set in the Client’s Preferences dialog:

een Preferences

" General | Print | Alerts

Print Using: ' Server H

Printer; Xerox iGen F"’H

Preview Using: .- Adobe Acrobat Professional I-%-!

Preview Type: Full Preview F’H
Distill PS Using: | Server 4

| Revert to Default Settings )

3. Downloading Files
The Download to Printer... option in the File menu downloads files through the Server. The
files have to be on one of the server volumes. Files are downloaded to the default printer,
specified in the Preference dialog.

11
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4.

Previewing

To preview PostScript files you can use a copy of Adobe Acrobat Distiller on the server or
you can choose to let each client convert PostScript into PDF. Previewing PDF jobs does not
require Distiller. The client displays the preview PDF files, either using the built-in
Preview application or Acrobat, according to the Client Preferences.

®6n Preferences

" General | Print | Alerts |

Print Using: Server

E &

Printer: Xerox iGen

]

Preview Using: A/ Adobe Acrobat Professional

Preview Type: r Full Preview |-H

Distill PS Using: Client e
:“Acmhat Distiller I_H

([ Revert to Default Settings )

In the installation directory on the Windows server there is a text file Distillr.dat which
contains the path to the Distiller application. You can edit this path manually if you have
multiple installations of the Distiller or you reinstall Distiller to a new location.

12
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Uninstalling Users

From the Client

A user can uninstall themselves from a Server to free their slot on the Server. You can only
uninstall a user if they are currently logged onto the Server.

To Uninstall a User

1. From the Client software, select Connect to Servers... from the Edit menu.

Click on the minus (-) button to remove that client’s license on the server

3. The Server will be removed from the list and the vacant slot will be available for another
user to log in.

N

From the Windows Server

1. From the Server software, select Users... from the Edit menu.
2. The Users dialog will show a list of all the users. Select the user that you want to uninstall
and click Uninstall. Note that only currently logged out users can be uninstalled from the

server.
M ame ] Active

| admir 1 Yes I ninztall |

f2l 4 Mo |
g3 3 Mo Cloze

john 9 Ter

mach 2 Ma

macint a Mo

performa 7 Ter

thiva 5 Yes

3. The User will be removed from the list and the vacant slot will be available for another
user to log in.
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